
 

 



 

免責事項 

 

本パンフレットに記載されている全ての製品、製品仕様及びデーター情報は信頼性、機能性、デザイン又はその他を改善する

為に予告なしに変更する事がありますので、ご注意お願い致します。Morgan AM&T B.V 及びその関連会社はこの情報の正確性

又は使用による損害については責任を負いません。使用条件による製品の適合性の記述については Morgan 製品が一般的に使

用されている条件をもとに作成されています。 

  



 

 

安全性 

備考：回転電気機械の作業中に基本安全ガイドラインを守のが重 

要です。 

例えば、全ての機械が作業前に完全に停止している事を確認する。 

 

現地の安全手順に応じているか、作業開始前に現場の安全衛生管 

理者に確認してください。 
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紹介  

整流子又はスリップリング「コレクター」の維持又は修復の主な目標はブラシ及びコレクターの寿命を低下させる事象を排除

する為です。理想では、コレクターの表面は滑らかであるべきで、状態の悪いコレクターは再研磨又は切削する必

要がある。 

一般的に、コレクターのTotal Indicated Runout(TIR)が76μm (3 mil) 以上、整流子のMaximum Bar-to-Bar Height (MBTB)

が7.6 μm (0.3 mil) 以上の場合に再際研磨又は切削が必要：  

 
 

 
 

MSPro14のようなプロファイリング測定器を定期的に使用することで、コレクターに問題があるか確認することが可能

となります。また、測定は少なくとも半年に一回、可能であれば２ヶ月に一回行うのが理想的です。測定情報からメン

テナンススケジュールをより簡単に計画することが出来ます。 
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合格範囲内の整流子プロファイル          合格範囲外の整流子プロファイル 

 

     

合格範囲内のスリップリングプロファイル       合格範囲外のスリップリングプロファイル 

 

Morgan Advanced Materialsからの最新版の表面プロファイラーMSPro14のご購入ありがとうございました。 

MSPro14は下記の為に使用します。 

• コレクター表面のプロファイリング及びTIR、MBTB、さらにコレクター外形の測定 

• コレクターのTIRは最小高さと最高高さの差。TIRは‘runout’ 又は 'out of roundness'とも表示されます。 

• 整流子のMBTB高さは二つの隣接しているバーの高さの差。MSPro14は整流子にハイマイカが付いているか判定するこ

とも出来ます。ハイマイカは隣接しているバーの間に隙間が見られない時に出来ます。ハイマイカは記録編集のダイア

ログウェィンドウでバーナンバーとして表示されます。 

• MSPro14は業界で‘Shape’モードと知られている方法で記録を取っています。Shapeモードはセンサーがコレクターの

表面の上を移動する時に測定し、その数値をもとにコレクターの形を生成することが可能です。Shapeモードは多数の

サンプルを記録して、プロファイルの記録を作成することが可能となり、磨耗のパターン及び事象の測定を行うことが

出来ます。 
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• Peak height モードを(DASPro14のソフトウェア内で)選択する事が可能で、このモードでは各バーに付き一つの数値が

表示されます-これはバー全体で検出された多数のサンプルの最大高さとなります。 

• 検出されたデーターはPCに移動することが可能で、キットに含まれているDASPro14のWindowsソフトウェアを使用

して細かく分析することも出来ます。 

 

他にMSPro14には: 

• 振動を含む極端な環境に耐えられて、様々のブラシホルダーのサイズにも対応できて、簡単に設置も可能の丈夫なセン

サーです。 

• 簡単操作のカラータッチスクリーンです。 

• らせん状に溝のあるスリップリングにも悪影響受けない最適化センサーヘッドです。 

• 簡単セットアップ用ゼロセッティングライトインジケーターです。 

• 過去にMorganから供給されたプロファイラー測定値 (.mas files) の保存と組み合わせが可能。 

• 情報の保存とデーター補足ボックスからの修正の為に大容量メモリーとなっています。 

• 全ての付属品が入った頑丈のキャリーケース付です。 
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電源スイッチ (1) 

センサーリードポート(2) 

USB ポート (3) 

LEDディスプレ「3色表示」: (4) 

• 緑 = 電源オンになっている 

• オレンジ = 電源オンになっていて、充電中 

• 赤 = 電源オフになっていて、充電中 

 

キットの標準付属品: 

頑丈な軽量ケースに入ったMSPro14のパックに下記の付属品が含まれている： 

• データー補足ユニット (測定するボックス) 

• 本マニュアル及び最新のPCスフとウェア(DASPro14 - Data Analysis Software)が入ったUSBスティック 

• センサー 

• センサー保護スリーブ及びセンサースペーサーセット 

• USBケーブル 

• AC充電器 

• 外部バッテリー 

• G (又はC)クランプ 

• 懐中電灯及びペン 
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提言 
ソフトウェアのインストール前及び装置の初使用前に本マニュアルを読んで下さい。マニュアルに含まれている指示に 

全て従って下さい。 

 

検査結果に大きく影響する為、検査前にコレクターの表面に腐食している塵/汚れを除去し、センサーヘッドもきれいに

なっていることを必ず確認して下さい。きれいで、糸くずが出ない布を使用、例えば、メガネレンズを拭く布など。 

 

センサーヘッドは高性能な製器で、通常の取り扱いに耐えられるように製造されていますが、常に注意しながら使用を

することを勧めします。センサーは使用されていない時には常に付属品のスリーブに保管するべき。 

 

プロファイル記録の際、センサーが可能な限り放射状に（理想的に±1°）及び下記の図に表示されている方面に回転す

れば、安定した結果を検出できます。  

 
 

 
 

いかなる状態においてもセンサーを直接クランプしないで必ずホルダーに設置するか、スリーブに入れて、そのスリー

ブをクランプで固定させて下さい。 

 

センサーを12ヶ月ごとに較正することをお勧めします。校正をするにはMSPro14を現地のMorgan営業所又は直接 

Morgan Advanced Materials Netherlandsにお申しつけ下さい。 
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初回の使用 

 

PCの最低条件: 

 
• OS: Windows XP以上 

• 最低100MBのディスク空き容量 

• 最低1GB RAM メモリー 

• 一個の空きUSB2.0ポート 

 

USBケーブルでPCに繋いだ時に、測定ボックスが新しいUSBディバイスとして表示されます。測定ボックスはWindows 

File Explorer 標準プログラムの使用でアクセスが可能です。アクセスする事で下記の操作が可能です： 

• 測定ボックス内のフラッシュメモリーに保存されているファイルにアクセス (各測定結果は一つのファイルとして保存

されます) 

• 測定ボックスのソフトウェアを更新 
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初期使用のソフトウェア登録 

付属のUSBメモリースティックをPCに繋ぎファイルを開き；下記と同じソフトウェアリンクをダブルクリック： 

 

 
 

スクリーン上の支持に従う；PC設定の影響により、ソフトウェアインストールについて注意表示があった場合“Yes”を

クリックして下さい、しかし、不安の場合必ずIT管理者に連絡して下さい。 

 
 

 

“I agree” をクリック 
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Nextをクリック 

 

 

保存先フォルダーが自動で選択されます; しかし, 変更が必要の場合変更をして“Next”をクリック 
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情報が正しい時“Install”をクリック 

 

 

インストールが完了した場合“Next”をクリック 
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初期使用前のDASPro14ソフトウェア登録の準備が完了し、以下のように登録を行います： 

 

PCデスクトップに表示されている、下記のリンクをダブルクリック： 

 
 

次のスクリーンを開かれます： 

 
 

登録キーを知っている場合、“Registration Key”のスペースに入力し、分からない場合”this link”をクリックしウェブペー

ジを開く： 

  



 

10 

 

http://www.morganelectricalmaterials.com/mspro14-registration-form 
 

全ての必須項目を入力されたら“Submit”ボタンをクリックしたら、登録キーがユーザーに送られる用に自動的に: 

MSPro14.register@morganplc.com にメールが送信されます。 

 

登録キーを入手したときに“Registration Key”のスペースに入力し、 “OK”をクリックしたらソフトウェアが立ち上がる。 
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ソフトウェア更新作業 

ソフトウェアは自動的に更新されません. PCソフトウェア及び測定ボックスの更新方法は下記の通りとなります： 

• ユーザーはPCソフトウェアの登録時に使用したメールアドレスに添付ファイルをメールで受信又は特定サーバーより

ダウンロードするように支持されます。 

• 測定ボックス： 

– PC又はノートパソコンに繋げる。 

– 測定ボックス内に特定のフォルダーに更新ファイルをコピー。 

– 測定ボックスをPC又はノートパソコンから外す。 

– 更新を起動する為にボックスを再起動。. 

• PCソフトウェア 

– 初期のインストール時と同じスクリーンの表に従う  
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MSPRO14測定ボックスの使用 

 
まずは、センサーをMSPro14測定ボックスに接続し、電源を付ける; 立ち上がるまで待ち、その時に下記のスクリーン

が表示される： 

 

ステータスバーがロード状況を表示し、全てがロードされたウェルカムスクリーンを表示される。 
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ウェルカムスクリーン 

 
本スクリーンではMSPro14の製品番号及びボックスソフトウェアのバージョン。 

右上のシンボルは下記の通りです： 

         

メモリーサイズが30Mbと少なくなっています. これは250分のデーターが保存できる量です。 
 

 
 

 

センサー位置 

 
 

現在設定されている単位 – メートル法又はインチ単位 

 
 
 

バッテリー容量 

 
 

 
 

始める際に“ok”を押して下さい 

 
 
 
 

ヘルプ 
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ホームスクリーン

 
使用オプションは4個: 

 
 

測定開始 

 
 
 
 

データー表示 

 
 
 
 
 

設定 

 
 
 
 

ヘルプ  
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設定 

 
本スクリーンから6個の設定の変更が可能です: 

日時 
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単位＆言語 

 
使用可能言語は5言語: 英語、オランダ語、フランス語、ドイツ語、スペイン語のみです。 

アラーム 

 

計測範囲に応じてアラームを設定できる 
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ディスプレ 

 

ディスプレの明るさが自動又は手動で設定が可能 

電源管理 
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センサー設定  

 

センサー番号が正しい場合に表示されるスクリーン 

センサー番号が有効ではない又は入力されていない場合表示されるスクリーン 
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測定開始 

 
測定を開始したい時には、まずはコレクターのタイプを決める必要があります、すなわち、整流子又はスリップリング 

整流子 
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本スクリーンでは出来る限りの情報を入力することで、自社専用特有機械データーベースを起こすこと可能となりま

す。機械を登録する為には上の３項目に情報を記入する必要があります： 

• 機械名 

• 製造者名 

• モデル 

 

また、バーの数が分かれば（外形の入力も可能ですが整流子の場合あまり正確ではありません）この情報も入力した方

が良い、その理由としては、自ら測定を終るするよりも、自動的に測定が終るします 

 

必要な情報をスクリーン上のキーパッドを使用して入力して下さい。右上に赤丸されている“０”は、もし過去に機械を

登録されていた場合数字が反映され、過去の登録した情報を再利用することが可能となります、その分情報の再入力を

しなくてすみます。 

 

次のスクリーンではTIR及びMBTBのアラームが必要か判断し、そしてもし必要であればそのアラームからなる数値の設

定も行います。初期設定の数値は先程説明されたアラーム設定のページで決まっています。 

 
  



 

21 

 

 

 

センサーの設定 

センサーは最大測定範囲を記録する為にはセンサーヘッドが移動距離の中間に設定すうようにデザインされました、す

なわち、実質上6mm(236mil)中3mm(118mil)。理想的のずれは0.00mm（0mil）ですが±0.2mm(±8mil)でもスター位置と

して使用することも可能。センサーを設置する方法は次の通りです： 

• クランプのグリップを反時計回りに回してゆるめ、クランプはなるべく平らにする 

• センサーを選び空のブラシボックス又はスリーブと共に必要の緩衝材（又は特注されたホルダー）に設置します、しか

しこの時点ではまだ完全に閉めないように。センサーがブラシホルダー穴に出来るだけまっすぐに設置するように注意

して下さい。整流子のプロファイルを測定している場合（理想的には）バーとバーの間ではなく、バーの中心に設置し

て下さい。 

• ディスプレの数値が±0.2mm 又は±8 milになるようにブラシホルダー穴に設置して下さい。この数値はディスプレで適

切なことばとアイコンと共に赤、オレンジ又は緑で表示されます。  
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• センサーヘッドの設置が終わった時に（理想的な状態の時ディスプレは緑になっている）、センサーが動かないように

ホルダー又はスリーブの中のクランプを閉めて下さい。センサーを閉めるときには工具や他の道具を使わず手で閉めて

下さい（閉めすぎがクランプにダメージを与える可能性があります）。. 

• 開始/停止場所が分かるようにコレクターの表面に印しを付けて下さい。 

• 次にセンサーを安定させる為には、コレクターをプロファイルの測定の際に回る方向と同じ方向に回して下さい。一回

転が不可能の場合コレクターを前後に回し下さい。一定の結果を測定する為には最後の動きをプロファイルの測定する

時と同じ方向に回して下さい。正しく出来たときには（スクリーンの左下）の‘Operational’及び‘Settled’の隣文字が‘OK’

と表示されます。 

• ディスプレの数値がまだ±0.2mm (±8mil)以下と表示されている事を再確認し、整流子を測定している場合印を付けたバ

ーの中心に位置されている事も確認して下さい。 

• センサーが正しく設置されていなくても続けることが可能です。すなわち矢印がオレンジの場合、しかし問題がある事

を知らせる為追加の警告が表示されます。 
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一つの測定を完成させる 

 

コレクターを回転して、ユニットが測定を開始する  
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回転が感知された時に  が  に変わる；バーの数が（又は外形）を入力された場合自動に停

止しするが, 入力されていない場合  を押す必要があります。 

測定結果のディスプレでの表示について 又は  のボタンを押すと変更することが可能です；こ

れは文字又はリアルタイムの線形グラフに交互することができます。 
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測定を完了すれば、下記のまとめページが表示されます: 

 

スクリーンの下のシンボルは下記の意味です: 

 保存せずにホームスクリーンに戻る 

 再測定をする、従って現在の結果を削除する  
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 アラーム/エラーを表示 – シンボルが赤くなっている場合 

 波形を表示 

 測定結果の保存 

 

もしアラームがなって/エラーが発動された場合下記の状態で表示されます: 

 
 

波形表示ボタンはユーザーに一般的形状の概要を表示し、ズームイン ・ ズームアウトも可能です。 
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ユーザーが測定結果を保存したい場合、下記のスクリーンが表示されます: 

 

初期のファイル名のフォーマットは：年/月/日-時間/分/秒で表示され –その為完全に固有となります；希望であればこ

のファイル名を上書き及び/又は編集することは可能です。 

機械の情報をデーターベースに登録する為には  ボタンを押す必要があります – 機械の情報がもうすでに

登録されている場合、又はユーザーが最近の結果で情報を更新した場合。 
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情報を  ボタンを押してデーターベースに移動することが可能です。 

 

 

ユーザーが結果を保存した時に  ボタンを押す必要があります。その後に次のオプションに続くきます： 
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Same Machineはユーザーをセンサー設定に戻す 

 
 

Different Machineはユーザーを測定開始スクリーンに戻す 

 
 
 
 

ホームスクリーンに戻る 
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スリップリング 

 

本スクリーンでは出来る限りの情報を入力することで、自社専用特有機械データーベースを起こすこと可能となる。機

械を登録する為には上の３項目に情報を記入する必要があります： 

• 機械名 

• 製造者名 

• モデル 

 

また、外形が分かればこの情報も入力した方が良い。その理由としては、自ら測定を停止するよりも、自動的に測定が

停止します 
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次のスクリーンではTIR及びLow Pointのアラームが必要か判断し、そしてもし必要であればそのアラームがなる数値の

設定も行います。初期設定の数値はアラーム設定のページで決まっています。 

 
 

センサーの設定 

センサーの設定は整流子に設定する時と同じ方法です。  
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一つの測定を完成させる 

 

コレクターを回転して、ユニットが測定を開始する 

 

回転が感知された時に  が  に変わる；外径を入力された場合自動に停止しするが, 入力され

ていない場合  を押す必要があります。  
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測定結果のディスプレでの表示について 又は  のボタンを押すと変更することが可能です；こ

れは文字又はリアルタイムの線形グラフに交互する。 

 

測定を完了すれば、下記のまとめページが表示されます: 

 

スクリーンの下のシンボルは下記の意味です:  
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 保存せずにホームスクリーンに戻る 

 再測定をする、従って現在の結果を削除する 

 アラーム/エラーを表示 – シンボルが赤くなっている場合 

 波形を表示 

 測定結果の保存 

 

もしアラームがなって/エラーが発動された場合下記の状態で表示されます: 

 
 

波形表示ボタンはユーザーに一般的形状の概要を表示し、ズームイン ・ ズームアウトも可能です。 
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測定結果は整流子の場合で説明された方法と同じで保存できます。 

機械の情報をデーターベースに登録する為には  ボタンを押す必要があります – 機械の情報がもうすでに

登録されている場合、又はユーザーが最近の結果で情報を更新した場合。 
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情報を  ボタンを押してデーターベースに移動することが可能です。 
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データーの表示 

ユーザーが以前測定した結果を見たければ、下記のスクリーンがディスプレに表示されます。 

 

スクリーンの横にある矢印でデーターセットをスクロールすることが出来ます 

必要のデーターセットが見つかった時に  ボタンを押して下さい。 次のページでその機械で測定した各結

果が表示されます: 
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必要な測定結果見つかった時に  ボタンを再度押して進みます；その後に測定後に表示された同じスクリ

ーンが表示されます、すなわち：

 

アイコンは以前に説明した通り選択できます。  
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スタンドバイスクリーン 

メインメニューの  ボタンからユーザーが下記のオプションを選択できます: 

 

 スクリーンを消す 

 ユニットの電源を消す 

 ホームスクリーンに戻る 

“Display Off” ボタンを押した後にスクリーンが消えて、スクリーンを再度押すと下記が表示されます。 
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スクリーンを再度押すとホームスクリーンに戻ります。 

“Power Off”ボタンは下記のスクリーンを表示します:  

 

 電源を消さずにホームスクリーンに戻る 

 ユニットの電源を消す  



 

42 
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PC分析ソフトウェア 

DASPro14 
DASPro14ソフトウェアを立ち上げる為には下記のリンクをダブルクリックして下さい： 

 
 

概要 

• DASPro14はWindows® XP 以上使用しているPC又はノートパソコンで稼動できます。 

• 複数の測定ボックスが一つのPC又はノートパソコンで管理できます。 

• PC又はノートパソコンに同時に一台の測定ボックスしかつなぐことが出来ません。同時に複数の測定ボックスを処理

するサポートはでません。 

• DASPro14のソフトウェアを使用する為にはライセンスは不要です。 

• 古いPCのプロファイルソフトウェアから測定ファイルを取り込むことが可能です。 

• PCで測定の準備が可能です。 

• 測定ボックスにダウンロードすることが可能です。 

 

ユーザー・インターフェース 

 
メインウィンドーに下記のエリアが含まれています: 

• (1) 選択されて、ダウンロードされたデーターセット 

• (2) 測定結果リスト: ダウンロードされたデーターセットから選択された測定結果。 

• (3) 表示エリア: このエリアは測定結果の表示、数値の表示、などに使用され、又複数のタブもあります： 

  

1 

2 
3 
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• タブバー: 

1. Info: “Info”タブは選択された測定の情報を表示し、ユーザーも修正する事も可能: 

 

a) ユーザー情報 (会社、オペレーター、など) 

b) アラーム設定: BTB, TIR, など 

c) 測定結果情報 (名前, 種類, サイズ, など) 

 

2. Values: このタブでは測定数値を数値形式で表示する。ユーザーが数値を修正する事が可能  

 

a) 数値をクリップボードにコピーして他のプログラムにペーストすることが可能 (例えば, Microsoft. Excel) 
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Chart: “Chart”タブは選択された測定結果のリニアープロットを表示する。使用できる機能は下記の通り:  

 

a) 左右上下への移動と拡大 

b) 回転、転換及びプロット整列 

c) 軸の尺度及び色の変更 

d) 水平及び/又は垂直のグリッド線を表示/非表示にする 

e) コピー(チャートプロット+凡例をクリップボードに画像としてコピー) 

f) 印刷(チャートプロット+ヘッダー) 

4. Radial: “Radial” タブは選択された測定結果の波形を表示する。使用できる機能は下記の通り: 

 

 

a) 左右上下への移動と拡大 
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b) 回転、転換及びプロット整列 

c) 軸の尺度及び色の変更 

d) 中心円、リミット円及び/又は中心グリッドラインの表示/非表示 

e) ラジアルプロット+凡例をクリップボードに画像としてコピーCopy radial plot + legend as a picture on the clipboard 

f) 印刷(ラジアルプロット+ヘッダー) 

 

• メニューバー 

1. File: ファイル関係の機能: 開く, 保存, 閉じる, など 

2. Box 
3. Tools 
4. Help 

• ボタンバー: ボタンバーでは定期的に使用する機能をボタンとして表示します。選択しているタブにより他のボタンも

利用可能となります。 

• ステータスバー: ステータスに情報を表示し、ステータス情報を表示する為に使用されています、例えば： 

1. 検出している測定ボックス 

2. PC/測定ボックスソフトウェアの更新があるかの情報 (将来のオプション) 

 

DASPRO14初期使用 

初期使用の時にデーターセットがダウンロードされる重要フォルダーを設定する必要があり；下記のスクリーンが表示

されます：（この設定は“Tools>Settings”からいつでも変更する事が可能） 

 

値及び言語もこのスクリーンで設定できます。 

 

DASPRO14の使用 

データーセットの追加 

測定結果を取り込みフォルダーに移動する方法は2種類あります: 

• 通常のファイルとして、関連しているファイルをMSPr14のユニットから直接ドラッグアンドドロップする。 
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• “Download from Measurement Box” を選択して現状の支持に従う 

 

PCにデーターセットを入れたら  ボタンで追加することが可能となり; データーセットが指定エリアに表示され

る。データーセットをクリックすると各測定結果が表示されます: 

 

個々の測定結果をダブりクリックすると測定結果リストに追加され４つのタブを使用し細かい詳細を見ることが可能と

なります。 
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印刷 

データーのリポートを印刷する為には、“File>Print Report”をクリックし、印刷をしたいオプションを選択して、スクリ

ーン上の支持に従う。  
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数値の読み取り及び比較 

• チャートが表示されている時にはプロファイルを追いながら、特定の情報を入手することが可能；表示の方法は十字線

を必要のポイントに置いて、マウスを左クリックすると水平及び垂直の線が現れ十時線がさしている場所の数値がチャ

ートの右上に表示されます。 

• 十字線をキーボードの右と左矢印キーで移動することが可能です。 

 

プロファイルに調整 

ユーザーがプロファイルの表示を６種類の方法で変更することが可能です。その為同じ機械を違うポイントで測定を開

始した場合、プロファイルを調整する事が可能となります。 

 プロファイルを1バー/セグメント左に移動 

 プロファイルを1バー/セグメント右に移動 

 プロファイルをオリジナルの位置に戻す 

 プロファイルをミラーリングする 

2個以上のプロファイが表示されている場合、プロファイルのバー/セグメントの一番高い所に合わせます。 

 

2個以上のプロファイが表示されている場合、プロファイルのバー/セグメントの一番低い所に合わせます 
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ズーム特徴 

• ズームは“Chart”及び“Radial”のタブのみで出来ます: 

1. ズームしたい場所にチャートの左側に左クリックする。 

2. マウスボタンを抑えたまま、長方形を左下に移動する 

3. ズームするにはマウスボタンを放す。水平にズームするには: 

4. 上記と同じ方法で進み、拡大したいエリアを選択する為にマウスを直接左又は右に移動する。二つの垂直の線がチャ

ート全体に表示され、選択したエリアを表示します。 

• 垂直にズームする為には: 

1. 上記と同じ方法で進み、拡大したいエリアを選択する為にマウスを直接上又は下に移動する。二つの水平の線がチャ

ート全体に表示され、選択したエリアを表示します。 

• ズームアウトするには: 

1. チャート内のどこにでも左クリックし、長方形を左上に移動し、クロスが付いている長方形が表示されます。マウス

ボタンを放した時にチャートがオリジナルのサイズと場所に戻ります。 

 
 

アラーム 

PCのソフトウェアで整流子及びスリップリングの下記の測定結果アラーム状態を調べることが可能です。 

もし  のボタンに色が付いていたら、選択されているプロファイルがアラーム状態となっていることを示してま

すが、もし白黒 であればアラーム状態ではありません: 

• TIR - Total Indicated Runout 

– プロファイルの最大と最小の高さの差 

• MBTB - Maximum Bar-to-bar 

– 隣接しているバーの高さに差 「整流子の場合」 

• MSTS - Maximum Segment to segment 

– 隣接しているセグメントの高さの差 「スリップリングの場合」 

• ハイマイカ 

– バーの下に凹んでいないマイカ絶縁 (整流子バーの間)をリストする 

 

.Masファイルのダウンロード 

過去にMorganが提供していたプロファイラーのバージョンで記録したプロファイルをダウンロードすることは可能； 

 その方法は“File>Importing MAS File…”を選択しスクリーン上の指示に従う。 
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付録A: 仕様 
下記の仕様が将来のバージョンの時に変更される可能性あります: 
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付録B: 保証及び修理 

保証 

保証はMSPro14装置の組立及び材質に関する不具合をカバーし、保証期間は請求後1年となっています。 

間違った使用又は素人使用によるダメージは保証に含まれていません。保証を無効にする為自らMSPro14ユニットのハ

ウジングを開けないで下さい。 

. 

修理及び較正 

修理は開発者/生産者により（又は権限の下で）行われ；他のでも修理は可能ですが、これは全てユーザーの責任となりま

す。 

修理が必要の場合には現地のMorgan代理店に連絡して下さい。今後の進み方について支持します。較正の場合にも現地

代理店に連絡しても問題ありません。 
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